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Preface

This User’s Guide explains how to use the Setup Wizard to install and configure the
Sun Java™ System Connector for Microsoft Outlook on your desktop. This guide also
describes how to use the Connector for Microsoft Outlook through the user interface.

The Sun Java System Connector for Microsoft Outlook will let you and your
coworkers use Microsoft Outlook as your email and calendar application while
connected to Sun Java System servers. The Connector software performs necessary
ongoing communications between Outlook and the Sun Java System server, so that
you will have access to your new mailbox and full use of your calendar, address book,
and other Outlook features.

Who Should Use This Book
You should read this book if you plan to install and use Sun Java System Connector
for Microsoft Outlook on your desktop.

Before You Read This Book
This book assumes that you are responsible for installing the Connector for Microsoft
Outlook software on your desktop and that you have a general understanding of the
following:

� The Internet and the World Wide Web

� Installing software on the following platforms:

� Microsoft Windows 2000
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� Microsoft Windows XP

� Microsoft Outlook

How This Book Is Organized
This book contains the following chapters:

Chapter 1 provides an overview of Connector for Microsoft Outlook.

Chapter 2 describes how to install Connector for Microsoft Outlook on your desktop.

Chapter 3 describes how to get started using Connector for Microsoft Outlook.

Chapter 4 describes how to set up Outlook properties to work with Sun Java System
servers.

Chapter 5 describes how to work with email folders.

Chapter 6 describes how to work with calendar folders.

Chapter 7 describes how to work with contacts.

Chapter 8 provides troubleshooting tips when using Connector for Microsoft Outlook.

Connector for Microsoft Outlook
Documentation Set
The following table summarizes the books included in the Connector for Microsoft
Outlook core documentation set.

TABLE P–1 Books in This Documentation Set

Book Title Description

Sun Java System Connector for Microsoft
Outlook 7 2005Q4 Deployment Planning
Guide

Describes the administrator’s process and
strategies for deploying Connector for Microsoft
Outlook to user desktops.
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TABLE P–1 Books in This Documentation Set (Continued)
Book Title Description

Sun Java System Connector for Microsoft
Outlook 7 2005Q4 Installation Guide

Describes how to install the administration
software that helps an administrator deploy
Connector for Microsoft Outlook to user
desktops.

Sun Java System Connector for Microsoft
Outlook 7 2005Q4 Administration Guide

Describes the administrator’s deployment
configuration program for the Connector for
Microsoft Outlook.

Sun Java System Connector for Microsoft
Outlook 7 2005Q4 User’s Guide

(This guide) Explains how to install, use and
configure the Connector for Microsoft Outlook on
your desktop. This guide also describes the user
interface.

Sun Java System Communications
Services 2005Q4 Release Notes

Contains last-minute information, including a
description of what is new in this current release,
known problems and limitations, installation
notes, and how to report issues with the software
or the documentation.

Related Books
For other server documentation, go to the following:

� Sun Java System Messaging Server documentation
(http://docs.sun.com/coll/1312.1)

� Sun Java System Calendar Server documentation
(http://docs.sun.com/coll/1313.1)

Typographic Conventions
The following table describes the typographic changes that are used in this book.
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TABLE P–2 Typographic Conventions

Typeface Meaning Example

AaBbCc123 The names of commands, files, and
directories, and onscreen computer
output

Edit your .login file.

Use ls -a to list all files.

machine_name% you have
mail.

AaBbCc123 What you type, contrasted with onscreen
computer output

machine_name% su

Password:

AaBbCc123 A placeholder to be replaced with a real
name or value

The command to remove a file
is rm filename.

AaBbCc123 Book titles, new terms, and terms to be
emphasized (note that some emphasized
items appear bold online)

Read Chapter 6 in the User’s
Guide.

A cache is a copy that is stored
locally.

Do not save the file.

Shell Prompts in Command Examples
The following table shows default system prompts and superuser prompts.

TABLE P–3 Shell Prompts

Shell Prompt

C shell on UNIX and Linux systems machine_name%

C shell superuser on UNIX and Linux systems machine_name#

Bourne shell and Korn shell on UNIX and Linux systems $

Bourne shell and Korn shell superuser on UNIX and Linux systems #

Microsoft Windows command line C:\
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Symbol Conventions
The following table explains symbols that might be used in this book.

TABLE P–4 Symbol Conventions

Symbol Description Example Meaning

[ ] Contains optional
arguments and
command options.

ls [-l] The -l option is not required.

{ | } Contains a set of choices
for a required command
option.

-d {y|n} The -d option requires that you
use either the y argument or the
n argument.

${ } Indicates a variable
reference.

${com.sun.javaRoot} References the value of the
com.sun.javaRoot variable.

- Joins simultaneous
multiple keystrokes.

Control-A Press the Control key while you
press the A key.

+ Joins consecutive
multiple keystrokes.

Ctrl+A+N Press the Control key, release it,
and then press the subsequent
keys.

→ Indicates menu item
selection in a graphical
user interface.

File → New →
Templates

From the File menu, choose
New. From the New submenu,
choose Templates.

Accessing Sun Resources Online
The docs.sun.comSM web site enables you to access Sun technical documentation
online. You can browse the docs.sun.com archive or search for a specific book title or
subject. Books are available as online files in PDF and HTML formats. Both formats are
readable by assistive technologies for users with disabilities.

To access the following Sun resources, go to http://www.sun.com:

� Downloads of Sun products
� Services and solutions
� Support (including patches and updates)
� Training
� Research
� Communities (for example, Sun Developer Network)
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Third-Party Web Site References
Third-party URLs are referenced in this document and provide additional, related
information.

Note – Sun is not responsible for the availability of third-party web sites mentioned in
this document. Sun does not endorse and is not responsible or liable for any content,
advertising, products, or other materials that are available on or through such sites or
resources. Sun will not be responsible or liable for any actual or alleged damage or
loss caused or alleged to be caused by or in connection with use of or reliance on any
such content, goods, or services that are available on or through such sites or
resources.

Sun Welcomes Your Comments
Sun is interested in improving its documentation and welcomes your comments and
suggestions. To share your comments, go to http://docs.sun.com and click Send
Comments. In the online form, provide the full document title and part number. The
part number is a 7-digit or 9-digit number that can be found on the book’s title page or
in the document’s URL. For example, the part number of this book is 819-2567.
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CHAPTER 1

Sun Java System Connector for
Microsoft Outlook Overview

Sun Java System Connector for Microsoft Outlook enables Sun Java Enterprise System
features and functionality to be available through Microsoft Outlook.

The following topics are discussed in this chapter:

� “What is Sun Java System Connector for Microsoft Outlook?” on page 15
� “Where to Find Other Information” on page 16

What is Sun Java System Connector for
Microsoft Outlook?
Sun Java System Connector for Microsoft Outlook enables Outlook to be used as a
desktop client with Sun Java Enterprise System.

Connector for Microsoft Outlook is an Outlook plug-in that must be installed on the
end-user’s desktop. Connector for Microsoft Outlook queries the Sun Java System
Messaging Server for folder hierarchies and email messages. It converts the
information into Messaging API (MAPI) properties that Outlook can display. Similarly,
it uses WCAP to query the Sun Java System Calendar Server for events and tasks
which are then converted into MAPI properties.

When users create and modify items through Outlook, Connector for Microsoft
Outlook passes the new message along to the appropriate server depending on its
message type. It sends new outgoing email to an SMTP mail server for delivery, and
sends modified email messages back to the user’s IMAP folder for storage. New
calendar events and tasks are converted into a standard format to be stored in the
Calendar Server database.
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Sun Java System Connector for Microsoft Outlook 7 2005Q4 includes support for
address book service. This service makes use of WABP and allows a user to have their
personal address book accessible from both Outlook and Sun Java System
Communications Express. In addition, users have access to a corporate directory in
conjunction with contacts and the user’s personal address book.

Where to Find Other Information
The Sun Java System Connector for Microsoft Outlook documentation can be found at
http://docs.sun.com as part of the Messaging Server documentation collection.

� Sun Java System Communications Services 2005Q4 Release Notes describes features,
known limitations and problems, system requirements, and other important
information about this release of Sun Java System Connector for Microsoft
Outlook.

� Sun Java System Connector for Microsoft Outlook 7 2005Q4 Installation Guide describes
how to install the administration software that helps an administrator deploy
Connector for Microsoft Outlook to user desktops.

� Sun Java System Connector for Microsoft Outlook 7 2005Q4 Deployment Planning Guide
describes the administrator’s process and strategies for deploying Connector for
Microsoft Outlook to user desktops.

� Sun Java System Connector for Microsoft Outlook 7 2005Q4 Administration Guide
describes the Desktop Deployment Configuration Program, which allows the
administrator to create custom end-user installation packages that configures and
customizes the software per the administrator’s specifications.

� Sun Java System Connector for Microsoft Outlook 7 2005Q4 User’s Guide (this book)
describes how to use the Setup Wizard to install and configure Sun Java System
Connector for Microsoft Outlook on a user’s desktop. Also describes the user
interface for Connector for Microsoft Outlook.
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CHAPTER 2

Installing and Configuring the
Software on Your Desktop

The Sun Java System Connector for Microsoft Outlook software must be installed and
configured on every user’s desktop, but after it’s installed it will become virtually
invisible to you. It will operate automatically, in the background, and will require no
maintenance whatsoever.

The system administrator of your network has prepared a special installation package
for you, called the Setup Wizard, to install and configure the Sun Java System
Connector for Microsoft Outlook on your desktop. These installation packages are
designed to simplify and automate the installation process, to spare you much of the
time and hassle of having to enter technical information and make technical choices by
yourself. Your Setup Wizard also contains a conversion program that can
automatically convert any existing Outlook data stored on your desktop— your old
messages, address books, contacts, calendar data and so forth— to the new format that
the Connector for Microsoft Outlook software can use.

About the Setup Procedure
The procedure to install the Sun Java System Connector for Microsoft Outlook on your
desktop may follow any of several different paths, depending on your current system
setup, the volume of data (if any) that you want to convert from the old Outlook
format to the new format, and other factors. This guide explains all of the screen
displays that may appear to various users, but it’s a rare case that any single user
would see them all, and the ones that don’t apply to you will be skipped.

System Requirements
The Sun Java System Connector for Microsoft Outlook requires:
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� Operating System: Windows 2000 (Service Pack 3 or higher) or Windows XP
(Service Pack 1 or higher). The Setup Wizard will not start under any other
operating system.

� Your default email client must be one of these versions of Microsoft Outlook:

� Outlook 2003

� Outlook 2002 with Office XP Service Pack 2 or higher

� Outlook 2000 in Corporate Mode (not in Internet Mode), with Office 2000
Service Pack 3 or higher.

Profiles that May Be Converted
The Setup Wizard can convert the following profile types to Outlook profiles that
work with the new Sun Java System Connector:

� Exchange profiles, and POP profiles;

� IMAP profiles from Outlook 2002/XP and Outlook 2003 (but not from Outlook
2000, where IMAP profiles cannot exist in Corporate Mode).

� Sun Java System Connector profiles earlier than version 7 2005Q4 from Outlook
2000 and Outlook 2002/XP (but not from Outlook 2003) can be upgraded
toConnector for Microsoft Outlook 7 2005Q4.

Folder Hierarchies for Migrated Data
The Sun server supports only one top-level folder within Outlook for each type of
data— Contacts, Notes, Calendar, Tasks or Journal. If the source folder hierarchy
contains more than one top-level folder for any one data type (as shown inFigure 2–1
below), only the primary (first-listed) folder appears in the top level after the
migration. The other folders of the same data type are migrated to a new second-level
folder named My [DataType], also shown in Figure 2–1.
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Contacts

Subcontacts

Other Contacts

Tasks

Subtasks

More Tasks

Notes

Other Notes

Contacts

Sun Java SystemSource System

Subcontacts

My Contacts

Other Contacts

Tasks

Subtasks

My Tasks

More Tasks

Notes

My Notes

Other Notes

FIGURE 2–1 Folder Hierarchies for Migrated Data

If a Large PST File Conversion Is Interrupted
If the conversion of a large file is interrupted before its completion (by a power failure,
for example), the Setup Wizard offers a Recovery feature that lets you complete a
conversion in progress rather than having to start over from scratch. If this should
happen to you, please see “If a Personal Folder (.pst) File Conversion Is Interrupted”
on page 61.

The Setup Procedure
This section describes the steps to follow in order to install and configure Sun Java
System Connector for Microsoft Outlook on your desktop.

Chapter 2 • Installing and Configuring the Software on Your Desktop 19



Step 1: Starting the Setup Wizard
Your network administrator will tell you how to start your Sun Java System Connector
for Microsoft Outlook Setup Wizard—most likely by finding the program name
through your Start button, or by an icon on your desktop, or by browsing to a
particular location in your network. But no matter how you start the Setup Wizard, the
procedure begins with the display of the Welcome screen shown in Figure 2–2.

FIGURE 2–2 Setup Wizard: Welcome Screen

� To Start the Setup Wizard

1. Read the Welcome message, and click the Next button.

The Setup Wizard then examines your system to verify the following:

� Microsoft Outlook is designated as your default email client, and your version
of Outlook is supported by this Connector software.

� the Sun Java System Synchronization program (previously known as the Sun
ONE Sync program), which is incompatible with this Connector software, is not
installed.

If Outlook is not set as your default email client, or if an incompatible Sun
synchronization program is installed, the Wizard notifies you and prompts you to
acknowledge the notice and exit the program. (You will be able to run this Setup
Wizard again after you correct the problem.) To resolve either of these problems,
see the instructions in Chapter 8 under:

� “If Microsoft Outlook Is Not Your Default Email Client” on page 59

Steps
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� “If a Sun Synchronization Program Is Installed, and Must Be Removed”
on page 60

Similarly, if your version of Outlook is not supported, the Wizard notifies you of
the problem and prompts you to exit the program, and you may rerun the Setup
Wizard after you upgrade to a supported version of Outlook.

Otherwise, if a supported version of Outlook is set to be your default email client,
and if no Sun synchronization program is installed: The Setup Wizard copies the
necessary files to your computer, and examines your system to see whether the
Microsoft Web Publishing Wizard (WPW) is installed. The WPW is a component
that lets you share your free/busy schedule with coworkers.

2. Determine whether or not Microsoft Web Publishing Wizard is already installed.

� If WPW is already installed: The Wizard moves on to the next phase of this
installation and setup process. Skip ahead to“Step 3: Selecting an Outlook User
Profile to Convert” on page 22 .

� If WPW is not installed: The Setup Wizard prompts you to install it now. Go on
to “Step 2: Installing Microsoft Web Publishing Wizard” on page 21.

Step 2: Installing Microsoft Web Publishing Wizard
This screen will not appear (and you may skip this step) if the Setup Wizard finds the
Microsoft Web Publishing Wizard (WPW) already installed on your computer. If,
however, WPW is not installed on your computer, you should install it now.

Your system administrator has previously specified the file name and location (path)
of an installable copy of WPW in your network, and the Setup Wizard displays that
information here, as shown in Figure 2–3.

Chapter 2 • Installing and Configuring the Software on Your Desktop 21



FIGURE 2–3 Setup Wizard: Checking for Minimum Installation Requirements

� To Install Microsoft Web Publishing Wizard

1. Click Next.

The Setup Wizard then displays the WPW License Agreement for you to read and
accept or decline.

2. Read the entire License Agreement, and click either Yes or No to indicate
whether you accept or decline its terms.

If you answer Yes: The installation kit installs WPW on your computer, and the
Setup Wizard moves on to the next phase of the installation process. Go on to “Step
3: Selecting an Outlook User Profile to Convert” on page 22.

If you answer No: The installation kit does not install WPW on your computer, and
the Setup Wizard aborts the entire Sun Java System Connector installation process.
(The Setup Wizard will install WPW and proceed with the installation only if you
accept the WPW License Agreement by clicking the Yes button.)

Step 3: Selecting an Outlook User Profile to
Convert
The screen shown in Figure 2–4appears only if your administrator has configured your
Setup Wizard to convert an existing profile, and if the Setup Wizard:

� finds two or more eligible Outlook user profiles connecting to Exchange server(s)
on your computer, or

Steps
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� finds only one eligible profile that is not set as your default.

FIGURE 2–4 Setup Wizard: Select Outlook User Profile to Convert

An “eligible” profile is any Outlook profile that:

� includes message services of at least one type previously designated by your mail
administrator (e.g., Microsoft Exchange, MS POP, MS IMAP, or an earlier version of
the Sun Java System Connector)

� has not yet been fully converted (all of its .pst files converted) by a previous run
of this Setup Wizard

If the Wizard finds only one eligible user profile, and the profile is designated as your
default profile, the Wizard will skip this screen on the assumption that you want to
convert the one eligible profile for the new software. Skip ahead to “Step 4: Selecting
Personal Folders (.pst) Files to Convert” on page 24.

Similarly, if the Wizard finds no eligible user profile to convert and your administrator
has configured the Wizard to create a new user profile in that case, this step 3 does not
apply to you— in fact, you can skip steps 4 and 5 too, and resume at “Step 6: Entering
New Account Login Information” on page 26.

� To Select a Profile for Conversion
This screen prompts you to select a single Outlook user profile to convert for use with
the new Sun Java System Connector software. It is very similar to the dialog box you
likely see when you start Outlook.

1. Use the drop-down list box to select the profile you want to convert.

2. Click Next.

Steps
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You may use the Setup Wizard to convert more than one profile, but only one at a
time. You must run the Setup Wizard again for each profile you want to convert.

When you click Next, the Setup Wizard finds all of the Personal Folders (.pst) files
associated with the user profile you have selected. Go on to “Step 4: Selecting Personal
Folders (.pst) Files to Convert” on page 24.

Step 4: Selecting Personal Folders (.pst) Files to
Convert
This screen appears only if you are converting an Exchange profile, and if the Setup
Wizard finds one or more “large” .pst files (exceeding a size limit specified earlier by
your mail administrator). If you are converting a POP or IMAP profile, or are
upgrading to Sun Java System Connector for Microsoft Outlook 7 2005Q4 from a
previous version, you may skip this step and the next, and resume at “Step 6: Entering
New Account Login Information” on page 26 below.

For current Exchange users, the Setup Wizard can convert Contacts, Journal and Notes
data from the Exchange server to the Sun Java System Connector profile. The Wizard
will automatically convert any .pst files if finds on your desktop that do not exceed
the size limit specified by your administrator. If none of your .pst files is “large,” the
Setup Wizard simply converts all of your .pst files, and you may skip ahead to “Step
5: Entering Exchange Account Login Information” on page 25. But if the Wizard finds
one or more “large” .pst files, the program asks you to specify which files (if any)
you want to convert at this time, as shown in Figure 2–5.

FIGURE 2–5 Setup Wizard: Select Personal Folders (.pst) Files to Convert

Next Steps
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The Setup Wizard will convert only those files that are checkmarked in the boxes to
the left of the corresponding file names. The displayed list may also include one or
more smaller .pst files, automatically checkmarked for conversion and grayed out
(so that you cannot unmark them).

The Wizard converts these files to make the mail addresses “live.” Unconverted email
messages would still be readable, but you would be unable to reply to them because
the unconverted addresses would be in a form that is unfamiliar to your new server.
On the other hand, converting large volumes of old messages can take a long time,
even several hours if your personal stores happen to run into gigabytes of data. The
conversions can run in the background, freeing you and your computer for other
work, but it may slow the performance of your other applications. For this reason, if
you have some personal stores that are very old, so that the need for a future reply is
highly unlikely although you’d like to be able to keep and read the data, you can elect
to not convert it. Another option is simply to defer the conversion of larger files to a
later time, such as during a lunch break or even overnight.

� To Select the .pst Files to Convert

1. Verify that all the files you want to convert now are marked, and that the files
you do not want to convert are not marked.

To add or remove a checkmark, simply click in the box.

2. Click Next.

The Wizard then prompts you to provide your personal login information for your
old Microsoft Exchange mailbox. Go on to “Step 5: Entering Exchange Account
Login Information” on page 25.

Step 5: Entering Exchange Account Login
Information
The screen shown inFigure 2–6 appears only if you have previously used Outlook on
this computer, and your system is configured to prompt you for this information when
you login to use the selected user profile. If you are a new email user who does not
have an existing account on the Exchange server, or if your system is configured to not
require this information when you log in, this screen will not appear and you may
skip ahead to “Step 6: Entering New Account Login Information” on page 26.

� To Enter the Requested Information for Your Microsoft
Exchange Mailbox

1. Enter your User name: the Windows account name associated with your
Exchange mailbox.

Steps
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2. Enter your Domain: the domain in which your Windows account resides.

3. Enter your Password: the password for your Windows account.

4. Click the Next button.

The Setup Wizard then prompts you to provide your personal login information
for your new Sun Java System account. Go on to “Step 6: Entering New Account
Login Information” on page 26.

FIGURE 2–6 Setup Wizard: Enter Microsoft Exchange Mailbox Information

Step 6: Entering New Account Login Information
This screen, shown in Figure 2–7, appears as part of the Setup procedure for all users,
to request your login credentials for the new Sun Java System server.
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FIGURE 2–7 Setup Wizard: Enter Microsoft Exchange Mailbox Information

Some of the fields in this screen may appear grayed out if your network administrator
has already entered this information for you. Similarly, the Save user name and
password checkbox will not appear if your administrator has pre-configured your
software to always or never require this information upon login to Outlook.

� To Enter the Requested Information for Your New Account

1. Enter your Full name: the name that appears in the From field of your outgoing
mail messages. This is the “friendly” name displayed to the recipients of your
messages.

2. Enter your Email address: your Internet email address.

3. Enter your User name: your account name.

4. Enter your Password: the password for your Sun Java System accounts.

5. If the Save user name and password checkbox appears in this screen: Check or
uncheck the option to indicate whether you want to be able to start Outlook
without being prompted for this login information every time.

6. Click the Next button.

The Setup Wizard then checks to see if any of the Personal Folders (.pst) files
scheduled for conversion are password-protected. Go on to “Step 7: Entering
Passwords for Protected Personal Folders” on page 28.

Steps
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Step 7: Entering Passwords for Protected Personal
Folders
The screen shown in Figure 2–8 appears in the Setup procedure if any of the Personal
Folders (.pst) files you have selected for conversion are protected by a password, and
the password is not saved in the password list. The screen reappears for each
password-protected .pst file that is scheduled for conversion. If none of your .pst
files is password-protected, or if all of the files’ passwords are saved in the password
list, the Setup Wizard simply begins converting the selected user profile and .pst
file(s), and you may skip ahead to “Step 8: Monitoring the Progress Meter” on page
29.

FIGURE 2–8 Setup Wizard: Enter Personal Folders (.pst) File Password

� To Enter the Personal Folders (.pst) File Password
The screen displays the name, size and location (path) of a password-protected
Personal Folders file (.pst file), and prompts you for the password that is required to
open the file.

1. Enter the password associated with the named .pst file.

2. Click Next.

When you have entered the password for the last .pst file that requires a password,
the Setup Wizard then begins converting the user profile. Go on to “Step 8: Monitoring
the Progress Meter” on page 29.

Steps
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Step 8: Monitoring the Progress Meter
The screen shown inFigure 2–9 illustrates the Wizard’s progress as it converts the
selected user profile and the “small” Personal Folders (.pst) files, and copies some
data (Contacts, Notes and Journals) from your Exchange server to a local store, so you
will have access to this data when you start using Outlook with your new Sun Java
System server.

FIGURE 2–9 Setup Wizard: Converting User Profile (Progress Meter)

When these processes are complete:

� If no “large” Personal Folders (.pst) files are being converted: The Wizard simply
displays a notification screen to let you know its work is finished. Go on to “Step 9:
Exiting” on page 30.

� If any “large” Personal Folders (.pst) files are being converted: The Wizard
notifies you that the profile conversion is complete, and prompts you to begin
converting the large Personal Folders files, as shown in Figure 2–10.
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FIGURE 2–10 Setup Wizard: Finishing PST as a Background Process

� To Begin Converting Large Personal Folders Files

� Click Next.

The Setup Wizard then minimizes itself to your Task Bar, to run the conversion(s)
in the background. Since the profile conversion is already complete, you may
immediately begin using Outlook with the new Sun Java System server, even as
the Wizard continues to convert your larger Personal Folders files. The large-file
Personal Folders conversion(s) may proceed for several minutes, or even hours,
depending on the size of the file(s) being converted.

The Wizard automatically displays a notification screen when the conversion is
finished. Go on to “Step 9: Exiting” on page 30.

� To View a Progress Meter in Real Time

� Restore the Setup Wizard from the Task Bar to its display window.

The Wizard automatically displays a notification screen when the conversion is
finished. Go on to “Step 9: Exiting” on page 30.

Step 9: Exiting
The contents of this Exit screen will vary depending on whether the Setup Wizard has
successfully installed the Sun Java System Connector for Microsoft Outlook. The title
of the screen reports success or failure.

Step

Next Steps
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Setup Process Completes
This screen (e.g., Figure 2–11) simply reports the successful completion of the
conversion(s) and of the overall Setup process. Just click the Exit button to clear this
screen and close the Setup Wizard. Congratulations! Your Sun Java System Connector
for Microsoft Outlook Setup procedure is now complete, and you may now begin
using Outlook with the new Sun Java System server.

FIGURE 2–11 Setup Wizard: Completing the Setup

Setup Process Fails
The Setup Wizard has abandoned the installation process, and the text in this screen
will explain why. When the Setup fails, this screen (Figure 2–12) offers a View Log
button that will display the contents of the program’s log file, which may offer
additional clues to help you diagnose a problem.

FIGURE 2–12 Setup Wizard: Setup Failed

A Setup failure will be due to one of these four problems:
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� Microsoft Outlook is not set as your default email client. For more information
and instructions to correct this problem, see “If Microsoft Outlook Is Not Your
Default Email Client” on page 59 in Chapter 6 of this User’s Guide.

� The Setup Wizard has detected the presence of an incompatible Sun
synchronization program on your computer. For more information and
instructions to correct this problem, see “If a Sun Synchronization Program Is
Installed, and Must Be Removed” on page 60.

� You are running a version of Microsoft Outlook or an associated Office Service
Pack that is incompatible with the Connector software. For more information
about this problem, see “System Requirements” on page 17 near the beginning of
this Chapter 2.

� You have declined the License Agreement for Microsoft’s Web Publishing
Wizard (WPW), which is a required accessory for the Sun Java System Connector
for Microsoft Outlook. The Setup Wizard will not install the Connector software
without the WPW, and it will not install the WPW without your acceptance of the
License Agreement.

Regardless of whether the Setup Wizard successfully completed the installation: Click
the Exit button to clear this screen and close the Setup Wizard.
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CHAPTER 3

Getting Started

Once Sun Java System Connector for Microsoft Outlook is installed and configured on
your desktop, you can open Outlook and begin using Connector for Microsoft
Outlook. This section describes the initial settings and appearance, and also some of
the typical getting started tasks.

The following topics are discussed in this chapter:

� “Starting Outlook” on page 33
� “Appearance” on page 33
� “Typical Initial Profile” on page 34
� “Accessing Your Inbox” on page 34
� “Accessing Your Calendar” on page 34
� “Accessing Your Contacts” on page 35

Starting Outlook
When you first start Outlook, you may be asked which profile to use. Select the
Connector for Microsoft Outlook profile that you created during installation and click
OK.

Appearance
When Outlook opens, you see:

� Outlook Shortcuts: Outlook Today, Inbox, Calendar, Contacts, Tasks, Notes, and
Deleted Items.
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� Folders List

The Folders List is made up of the following:

� Your mail Inbox and other mail folders in your specified mail server.

� Your Calendar, Tasks, and Shared Calendars which are stored on the calendar
server.

� Your Contacts are stored on the address book server.

� Your Outbox which is a local folder used for sending mail.

Typical Initial Profile
The Sun Java System Connector for Microsoft Outlook software that is installed on the
client enables server-side features and functionality available through the user
interface. A typical Connector for Microsoft Outlook profile consists of:

� Mail — the information store for incoming mail (IMAP) and SMTP transport for
outgoing mail.

� Calendar — the information store for calendar data.

� Address Book — the information store for contacts.

Accessing Your Inbox
You can access your email Inbox on the Sun Java System Messaging Server using one
of the following methods:

� Select the Inbox subfolder under Folders - your name.
� In the Outlook Today view, select Inbox under the Messages category.
� Click Inbox under the Outlook Shortcuts view.

Accessing Your Calendar
You can access your default calendar on the Sun Java System Calendar Server using
one of the following methods:

� Select the Calendar subfolder under Folders - your name.
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� In the Outlook Today view, select Calendar.
� Select Calendar under the Outlook Shortcuts view.

Accessing Your Contacts
You can access your contacts on the Sun Java System Address Book Server using one
of the following methods:

� Select Contacts under Folders - your name.
� Select Contacts under the Outlook Shortcuts view.
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CHAPTER 4

Configuring Connector for Microsoft
Outlook

This section describes how to set up your Outlook properties to work with Sun Java
System Connector for Microsoft Outlook and the servers for mail, calendar, and
address book.

The following topics are discussed in this chapter:

� “Configuring Servers and User Accounts” on page 37
� “Configuring Mail Properties” on page 39
� “Configuring Calendar Properties” on page 40
� “Configuring Address Book Properties” on page 40
� “Configuring Global Address List Properties” on page 41
� “Configuring Store and Logging Properties” on page 42

Configuring Servers and User Accounts
Your initial server and user account settings should be configured when you set up
your profile with the Deployment Configuration Program.

� To Change the Initial Configuration Settings

1. Exit Outlook.

2. Right-click the Microsoft Outlook icon and select Properties.

3. When the Services window opens, choose Folders - your name and click
Properties.

The Sun Java System Connector for Microsoft Outlook properties dialog appears.
Make sure the Sun Java Enterprise System tab is selected.

Steps
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a. Within this tab, you can change the servers and settings for the following
Sun Java System servers:

� Incoming Mail — name and port number of the Messaging Server on which
you receive incoming mail. The default port number is 143.

� Outgoing Mail — the name and the port number of the Messaging Server
via which to send messages using the SMTP protocol. The default port
number is 25.

� Calendar — name of the server and the port number on which the Calendar
Server is running. The default port number is 80.

� Address Book — name and the port number on which the Address Book
Server is running. This is where your Contacts are stored. The default port
number is 80.

� Global Address List — name and port number on which the corporate
directory is located. The default port number is 389.

If the SSL checkbox is enabled for any of the above servers, an SSL connection
will be attempted, using the port specified in Port.

b. You can configure the following user settings within the Sun Java Enterprise
System tab:

� Full Name — a readable form of your name. It is used to add descriptive
information to your email address when generating and sending mail
messages.

� User Name — your userID that the servers use to access your information.

� Password — your password. Enable the Remember Password checkbox if
you wish to have an encrypted form of your password saved into the local
registry. If not checked, the password is not saved, and you are always
prompted for the password when initiating a client session.

� Email Address — your email address. This is the address placed in a
message’s From: header, if the composed message does not have a from field
to override it. It is often used to identify the return address when the
receiver of a message needs to generate replies, receipts, notifications, and so
on.

4. When you are finished making changes, click OK.
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Configuring Mail Properties

� To Change Mail Properties

1. In the Folders List, right-click Folders - your name.

2. In the pop-up menu, select Properties for Folders - your name.

3. In the Mail Folder Properties window, click the Advanced button.

4. In the Sun Java System Connector for Microsoft Outlook properties dialog,
select the Mail tab.

Within this tab, you can change the properties for incoming mail (IMAP) and
outgoing mail (SMTP):

� Synchronize Mail folders every x minutes — the interval after which a server
mailbox may be polled for any recently-arrived messages. If any new messages
arrive, the mailbox is refreshed and redisplayed. This value defaults to 5
minutes. A minimum frequency of 1 minute is enforced. If this field is cleared or
set to zero, no polling will be performed for this server connection.

� Offline settings

� Download messages — If this option is enabled all messages in folders that
have been selected for offline use are downloaded into the local cache when
working in offline mode. See “Working Offline” on page 46 for instructions
on how to work offline. See “Selecting a Folder for Offline Use” on page 47
for instructions on how to select a folder for offline use. By default your
Inbox is downloaded.

� Do not download messages if they are larger than X KB — If this option is
enabled, only messages that are smaller than the value entered into the field
are downloaded into the local cache when working in offline mode. This
field is primarily intended to reduce download times when going into offline
mode.

� Server requires Authentication — if this checkbox is enabled, SMTP
authentication is required for sending mail.

� Use Alternate Account — if this checkbox is enabled, the SMTP server uses the
provided User Name and User Password for SMTP AUTH authentication. If the
checkbox is not enabled, it is defaulted to Sender’s email Address.

� Send BCC to sender’s E-mail address — if this checkbox is enabled, any email
that is sent will have the email address in the BCC. This effectively provides a
way for senders to file a copy of all messages they send. The messages are filed

Steps
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within a sender’s server INBOX, and will be subsequently affected by any
server-based message filtering rules.

5. When you are finished making changes, click OK.

Configuring Calendar Properties

� To Change Calendar Properties

1. In the Folders List, right-click Folders - your name.

2. In the pop-up menu, select Properties for Folders - your name.

3. In the Mail Folder Properties window, click the Advanced button.

4. In the Sun Java System Connector for Microsoft Outlook properties dialog,
select the Calendar tab.

Within this tab you can change the following Calendar properties:

� Synchronize Every x minutes— the amount of time you want Outlook to sync
information with the Calendar Server.

� Use Alternate User account — if this checkbox is enabled, Calendar Server uses
an alternate user account than the account specified under the Sun Java
Enterprise System tab. Enter the User Name and User Password for this
alternate Calendar Server account in the appropriate fields.

5. When you are finished making changes, click OK.

Configuring Address Book Properties

� To Change Address Book Properties

1. In the Folders List, right-click Folders - your name.

2. In the pop-up menu, select Properties for Folders - your name.

Steps
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3. In the Mail Folder Properties window, click the Advanced button

4. In the Sun Java System Connector for Microsoft Outlook properties dialog,
select the Address Book tab.

Within this tab you can change the following Address Book properties:

� Address Book Server URL — add the URL path portion to the server
information. This is the URL used to connect to the Address Book Server from
Outlook. The default URL is http://server:80/uwc.

� Use Alternate User account — if this checkbox is enabled, Address Book Server
uses an alternate user account than the account specified under the Sun Java
Enterprise System tab. Enter the User Name and User Password for this
alternate Address Book Server account in the appropriate fields.

5. When you are finished making changes, click OK.

Configuring Global Address List
Properties

� To Change Global Address List Properties

1. In the Folders List, right-click Folders - your name.

2. In the pop-up menu, select Properties for Folders - your name.

3. In the Mail Folder Properties window, click the Advanced button

4. In the Sun Java System Connector for Microsoft Outlook properties dialog,
select the Advanced tab.

Within this tab you can change the following global address list properties:

� Search Base — the basedn from which the LDAP searches are performed.

� Use Alternate User account — if this checkbox is enabled, the global address
list uses an alternate user account than the account specified under the Sun Java
Enterprise System tab. Enter the User Name and User Password for the
alternate account in the appropriate fields.

� Anonymous bind — if this checkbox is enabled, LDAP does not authenticate
before performing a search. This option is useful for environments that do not
have strong access controls. Do not enable this checkbox if your LDAP server
requires authentication.

Steps
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5. When you are finished making changes, click OK.

Configuring Store and Logging
Properties

� To Change Store and Logging Properties

1. In the Folders List, right-click Folders - your name.

2. In the pop-up menu, select Properties for Folders - your name.

3. In the Mail Folder Properties window, click the Advanced button

4. In the Sun Java System Connector for Microsoft Outlook properties dialog,
select the Advanced tab.

a. Within this tab you can change the following information store properties:

� File Path — the path for the PST database files. This setting cannot be
changed.

� Synchronize All — updates the local Outlook mail, calendar, task, and
contacts data from the Mail Server, Calendar Server, and Address Book
Server. This will delete all local mail, calendar, contact, and task items. All
mail, calendar, task, and contacts attachments and embedded data objects
will also be removed. Click Yes to continue or No to cancel.

� Personal Folders — updates your personal folders information.

b. You can also change the following logging properties:

� Log File — the location of the log file. The default is C:\\Documents and
Settings\userid\Local Settings\Temp\Sun Outlook Connector
Logs\sjoc.log. This setting cannot be changed.

� Log Level — specifies the level of logging. The choices are: Debug Low,
Debug, Information, Warning, Error, and Critical Error.

5. When you are finished making changes, click OK.
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CHAPTER 5

Working with Email Folders

This section describes how to work with email folders and provides some tips on
features that are specific to Sun Java System Connector for Microsoft Outlook.

The following topics are discussed in this chapter:

� “Accessing Your Inbox” on page 43
� “Sharing Your Mail Folders” on page 44
� “Subscribing to a Shared Mail Folder” on page 45
� “Unsubscribing from a Shared Mail Folder” on page 45
� “Working Offline” on page 46
� “Changing the Folder Class” on page 47
� “Synchronizing Folders” on page 48
� “Setting Up an Out of Office Message” on page 49
� “Setting Up Mail Filters” on page 49

Accessing Your Inbox
You can access your email inbox on the Sun Java System Messaging Server using one
of the following methods:

� Select the Inbox subfolder under Folders - your name.
� In the Outlook Today view, select Inbox under the Messages category.
� Select Inbox under the Outlook Shortcuts view.
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Sharing Your Mail Folders
You can grant access to or share one of your mail folders to other users. The user may
then subscribe to that shared folder.

� To Share One of Your Mail Folders

1. Right-click the folder you wish to share and select Properties.

The properties dialog for that folder appears.

2. Select the Permissions tab.

3. Within the Permissions tab:

� If you know the userID of the person to which you want to share this folder,
enter the userID and click Add. The specified userID appears in the list below.

� If you do not know the userID, click Search to search your address book
directory.

4. Select the userID (or anyone) from the list and choose the permission rights you
wish to grant.

The available permission rights are:

� Read only
� Read and write
� Read, write, and manage
� None

You must select at least read only in order to share a folder with another user.

5. If you wish messages to be sent directly to this folder, enable the “Enable direct
delivery of email to this folder” checkbox. This enables the ability to send email
directly to this folder using the following syntax:

user part of email address + folder name @ domain part of email address

For example, if the checkbox is enabled in John Smith’s engineering folder,
anybody will be able to send a message to John using the address
john.smith+engineering@sesta.com. This message is delivered directly in
the engineering folder. If the checkbox is not enabled, a message sent to such an
address is delivered to John Smith’s Inbox.

6. Click Apply to apply changes or OK to apply changes and exit the dialog.
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Subscribing to a Shared Mail Folder

� To Subscribe to a Shared Mail Folder

1. In the Folder List, right-click Shared Folders and select Properties.

The Shared Folders Properties dialog appears.

2. Select the Subscribe tab.

3. Click Subscribe.

4. In the Add Shared Folders dialog:

� If you know the owner’s userID of the folder to which you wish to subscribe,
enter that userID and click Query.

� If you do not know the owner’s userID, click Search to search your address
book directory for available folders.

The folders that are available to be shared and are not already subscribed by you
are listed. Select one or more folders in the list and click Add to subscribe.

5. Click OK and the subscribed folders appear in the Shared Folders list in the
Shared Folders Properties dialog.

6. Click OK in the Shared Folders Properties dialog and the subscribed folders
appear as a subfolder of your Shared Folders.

Unsubscribing from a Shared Mail
Folder

� To Unsubscribe from a Shared Mail Folder

1. In the Folder List, right-click Shared Folders and select Properties.

The Shared Folders Properties dialog appears.
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2. Select the Subscribe tab.

A list of subscribed folders appears in the Shared Folders list.

3. Select the folder from which you wish to unsubscribe and click Unsubscribe.

4. Click OK and your Shared Folders are updated to remove that folder.

Note

You cannot change the permission rights of a shared folder—only the folder owner
can change permissions. You can only view the permissions granted to you.

Working Offline
You can choose to work offline with your Sun Java System Connector for Microsoft
Outlook folders.

Setting the Offline and Online Mode

� To Work Offline

1. In the File menu select Work Offline (Sun Java System Connector).

The Work Offline dialog appears.

2. Click Yes to download messages before going to offline mode. You can set the
size limit of the downloaded. See “Configuring Mail Properties” on page 39 for
instructions on setting these properties.

Only the messages in folders selected for offline use will be downloaded. See
“Selecting a Folder for Offline Use” on page 47 for instructions.

Click No if you do not wish to download any messages.

A check appears next to this menu item.

Once you are in offline mode, Connector for Microsoft Outlook disconnects from the
server, and all subsequent operations (for example composing, deleting, and moving
messages) will occur on your local machine until you switch back to online mode.

More
Information
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� To Return to Online Mode

� In the File menu select “Work Offline (Sun Java System Connector).”

The check disappears from this menu item.

Selecting a Folder for Offline Use
You can specify a folder to download for offline use.

� To Select a Folder for Offline User

1. Right-click on the folder you want to download and select Properties.

The Properties dialog for that folder is displayed.

2. Select the Advanced tab.

3. Enable the box next to “Select this folder for offline use.”

4. Click OK or Apply.

Changing the Folder Class
You can use Outlook’s New→Folder menu option to create a folder that contains
calendar, contact, journal, note, task, or mail items. These items in any newly created
folder are stored on the mail server.

Note – The items in the default Journal and Notes folders are stored on the mail server.
The items in the default Calendar, Tasks, and Contacts folders are stored in the
calendar server (Calendar and Tasks) and address book server (Contacts). Any
subfolder under these default Calendar, Tasks, and Contacts are locally stored.

This feature allows you to create a new Contacts folder that is stored on the mail
server, for example, and share it with another user. However, if another user has
created a new shared Contacts folder and you subscribe to it, or if you log onto
Outlook using a different machine, all folders stored on the mail server are assumed to
be mail folders unless you change the folder class to correct this.
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� To Change the Folder Class

1. Right-click on the folder you want to change and select Properties.

The Properties dialog for that folder is displayed.

2. Select the Advanced tab.

3. Enable the box next to Change this folder to contain.

4. Select which class of folder you want from the pull-down list.

5. Click OK or Apply.

Synchronizing Folders
You can synchronize a single mail folder or all folders (including mail, calendar, tasks,
and contacts). Synchronizing updates the local data from the server. This deletes all
local items. All mail attachments and embedded data objects will also be removed.

� To Synchronize a Single Mail Folder

1. From the folders list, right-click on a mail folder.

The folder properties window is displayed.

2. In the folder properties window, select the Advanced tab.

3. Click “Empty and resync.”

A dialog appears indicating that the folder is synchronizing. The dialog disappears
when complete.

4. Click OK to close the folder properties window.

Synchronizing All Folders

To synchronize all folders, including mail, calendar, tasks, and contacts, see
“Configuring Store and Logging Properties” on page 42.
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Setting Up an Out of Office Message
You may wish to set up an out of office message to be sent as a reply to senders in
your absence.

� To Set Up Your Out of Office Message

� Select Tools→Out of Office Message.

A browser opens to the “Options — Mail Vacation Message” page of Sun Java
System Communications Express. You can set up your out of office message from
this page.

Setting Up Mail Filters
You may wish to apply filters to your mail folders.

� To Apply Filters to Mail Folders

� Select Tools→Mail Filter.

A browser opens to the “Options — Mail Filters” page of Sun Java System
Communications Express. You can set up mail filters from this page.

Step
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CHAPTER 6

Working with Calendar Folders

This section describes how to work with calendar folders and provides some tips on
features that are specific to Sun Java System Connector for Microsoft Outlook.

The following topics are discussed in this chapter:

� “Accessing Your Calendar” on page 51
� “Sharing Your Calendar” on page 51
� “Subscribing to a Shared Calendar” on page 52
� “Unsubscribing From a Shared Calendar” on page 53
� “Synchronizing Folders” on page 53

Accessing Your Calendar
You can access your default calendar on the Sun Java System Calendar Server using
one of the following methods:

� In the Folder List, select the Calendar subfolder under Folders - your user name.

� In the Outlook Today view, select Calendar.

� Select Calendar under the Outlook Shortcuts view.

Sharing Your Calendar
You can grant access to your calendar to another user. That user may then subscribe to
your calendar. The access permissions range from being able to read your calendar, to
allowing another user to create, modify, or delete events in your calendar.
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� To Share Your Calendar

1. Right-click Calendar from Folders - your user name and select Properties.

The Calendar Properties window appears.

2. Select the Permissions tab.

3. Click Add user.

4. In the Add User dialog, enter the userID and choose the permission settings, or
click Search to search for a user.

5. Click OK to delegate access to your calendar to the specified user.

Note

If you are granted access to another calendar, and create an event in that calendar, the
calendar owner is listed as the organizer of that event. Any email reminders sent about
that event is sent on behalf of the calendar owner.

Subscribing to a Shared Calendar
Another user can grant you access to his or her calendar.

� To Subscribe to a Shared Calendar

1. In the Folder List, right-click Shared Calendars and select Properties.

The Shared Calendar Properties dialog appears.

2. Select the Subscribe tab.

3. Click Subscribe.

4. In Add Calendar dialog:

� If you know the userID of the calendar to which you wish to subscribe, enter
that userID and click OK.

� If you do not know the userID of the calendar to which you wish to subscribe:

a. Click Search.
b. Select the user from the list in the Address Book dialog and click OK.

Steps
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5. Click OK in the Shared Calendar Properties window.

The calendar is added to your list of subscribed calendars.

Unsubscribing From a Shared Calendar

� To Unsubscribe From a Shared Calendar

1. In the Folder List, right-click Shared Calendars and select Properties.

The Shared Calendar Properties dialog appears.

2. Select the Subscribe tab.

A list of subscribed calendars appears in the Calendars list.

3. Select the calendar from which you wish to unsubscribe.

4. Click Unsubscribe.

A dialog appears asking if you wish to unsubscribe from this calendar.

5. Click yes to unsubscribe. Click no to cancel.

The calendar will be deleted from your subscribed calendar list.

Synchronizing Folders
You can synchronize a calendar folder or all folders (including mail, calendar, tasks,
and contacts). Synchronizing updates the local data from the server. This deletes all
local items. All calendar attachments and embedded data objects will also be removed.

� To Synchronize a Single Calendar Folder

1. From the folders list, right-click on a calendar folder.

The folder properties window is displayed.

2. In the folder properties window, select the Advanced tab.

Steps
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3. Click “Empty and resync.”

A dialog appears indicating that the folder is synchronizing. The dialog disappears
when complete.

4. Click OK to close the folder properties window.

Synchronizing All Folders

To synchronize all folders, including mail, calendar, tasks, and contacts, see
“Configuring Store and Logging Properties” on page 42.

More
Information
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CHAPTER 7

Working with Contacts

This section describes how to work with contacts and provides some tips on features
that are specific to Sun Java System Connector for Microsoft Outlook.

The following topics are discussed in this chapter:

� “Accessing Your Contacts” on page 55
� “Sharing Your Contacts” on page 55
� “Subscribing to Shared Contacts” on page 56
� “Unsubscribing From Shared Contacts” on page 57
� “Adding Shared Contacts to Select Names Dialog” on page 57
� “Removing Shared Contacts from Select Names Dialog” on page 58

Accessing Your Contacts
You can access your contacts on the address book server using one of the following
methods:

� Select the Contacts subfolder under Folders — your name.
� Select Contacts under the Outlook Shortcuts view.

Sharing Your Contacts
You can grant access to your contacts to other users. The user may then subscribe to
your contacts. The access permissions range from being able to read your contacts, to
allowing another user to create, modify, or delete contacts.
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� To Share Your Contacts

1. Right-click Contacts from Folders — your user name and select Properties.
The Contacts Properties window appears.

2. Select the Permissions tab.

3. Enter the user’s ID and click Add, or click Search to search for users in your
Address Book directory.

4. Choose the permission settings when the user’s ID is highlighted.

5. Click OK to delegate access to your contacts to the specified user.

Subscribing to Shared Contacts
Another user can grant you access to his or her contacts.

� To Subscribe to Another User’s Contacts

1. In the Folder List, right-click Shared Contacts and select Properties.
The Shared Contacts Properties dialog appears.

2. Select the Subscribe tab.

3. Click Subscribe.

4. In the Add Shared Contacts dialog:

� If you know the userID of the contacts to which you wish to subscribe, enter
that userID and click Query.

� If you do not know the userID of the contacts to which you wish to subscribe:

a. Click Search.
b. Select the user from the list in the Address Book dialog and click OK.

The userID and contacts are listed in the contacts list.

5. In the Add Shared Contacts dialog, select the userID from the contacts list and
click Add.

6. Select the userID in the Shared Contacts Properties window and click OK.
The user’s contacts are added to your list of subscribed contacts.

Steps
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Unsubscribing From Shared Contacts

� To Unsubscribe From a Shared Contact List

1. In the Folder List, right-click Shared Contacts and select Properties.

The Shared Contacts Properties dialog appears.

2. Select the Subscribe tab.

A list of subscribed contacts appears in the Contacts list.

3. Select the contacts from which you wish to unsubscribe.

4. Click Unsubscribe.

The contacts are deleted from your subscribed contacts list.

Adding Shared Contacts to Select Names
Dialog
When composing a new message, you can click the To button which displays the
“Select Names” dialog. This dialog displays addresses from your Contacts and the
global address list.

� To Add a Shared Contact Folder to the Select
Names Dialog

1. In the Folder list, right-click Contacts and select Properties.

The Contacts Properties dialog appears.

2. Select the Outlook Address Book tab.

3. Enable the “Show this folder as and e-mail Address Book” checkbox.

4. Click OK.

Steps
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Removing Shared Contacts from Select
Names Dialog
After unsubscribing to a shared contact, it is not automatically removed from the
“Select Names” dialog.

To remove the shared contact from this list, two solutions exist:

� If the subscribed contact has been added to the Select Names dialog, uncheck the
“Show this folder as an e-mail Address Book” checkbox from the Outlook Address
Book property page before unsubscribing from the contact.

� Remove the contact directly from the address book properties:

In Outlook XP:

1. Select Tools→Email account.

2. Choose “View or change existing directories or address books” and select
“Microsoft Outlook Address Book” to change.

3. Select the item to remove from your address book.

In Outlook 2000:

1. Select Tools→Services from the Outlook menu.

The Services window is displayed.

2. Select the Services tab.

3. Select “Outlook Address Book” from the list of services set up in your profile
and click Properties.

The Microsoft Outlook Address Book properties window is displayed.

4. Select the item to remove from your address book and click close.

Note – The user must log out and log in again for the change to take effect.
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CHAPTER 8

Troubleshooting

This chapter provides troubleshooting tips when using Sun Java System Connector for
Microsoft Outlook.

If Microsoft Outlook Is Not Your Default
Email Client
The Sun Java System Connector for Microsoft Outlook can be installed only if
Microsoft Outlook is set to be your default email client. If Outlook is not set as your
default email client, the Setup Wizard will notify you of the problem (in an error
message after the Welcome screen), and prompt you to acknowledge the notice and
exit the program.

� To Set Outlook as Your Default Mail Client

1. Open your Windows Control Panel. If you are running Windows XP (only):
Select “Switch to Classic View.”

2. Double-click on Internet Options.

3. Select the Programs tab from the Internet Properties window.

4. Select Microsoft Outlook from the Email pull-down menu.

5. Click OK.

You may rerun the Setup Wizard after you set your default email client to Outlook.

Steps
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If a Sun Synchronization Program Is
Installed, and Must Be Removed
The MAPI services for the Sun Java System Connector for Microsoft Outlook are a
required component of the Connector installation, but cannot coexist with the Sun
Java System Synchronization program (previously known as the ONE Sync program).
If one of these Sun synchronization programs is installed on your workstation, the
Setup Wizard will notify you of the problem (in an error message after the Welcome
screen), and prompt you to acknowledge the notice and exit the program. You may
then rerun the Setup Wizard after you remove the synchronization program.

Note – To synchronize your Palm device, WinCE device or Pocket PC device with
Outlook, we strongly recommend that you use the sync software distributed with
your device, rather than the Sun synchronization software. Changing to the sync
software distributed with your device may require uninstalling and reinstalling the
Palm Desktop software.

� To Remove the Synchronization Program

1. From your Start menu: Select the Uninstall... option for the program you want to
uninstall.

Select one of the following:

� Programs→Sun Java System Synchronization→Uninstall Sun Java System
Synchronization

� Programs→Sun ONE Synchronization→Uninstall Sun ONE Synchronization.

2. In the Uninstallation window, follow the prompts to uninstall the software.

3. Click Finish to complete the uninstallation process.

If you want to continue using the Sun synchronization software to sync to the data of
your other device: Reinstall the software, but do not select the checkbox for the
Microsoft Outlook 98/2000 translator during the installation.

Steps
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If a Personal Folder (.pst) File
Conversion Is Interrupted
Since Personal Folder (.pst) file conversions can run for many minutes or even hours
for large files, an interruption of the process— by a power failure, for example— could
be especially inconvenient if it meant having to repeat the lengthy process from
scratch. The Setup Wizard therefore offers a recovery feature that lets you resume an
interrupted conversion from wherever it was interrupted. Note that this recovery
feature is available only when an interruption occurs during a “large” Personal Folder
conversion— not during a profile conversion or during the conversion of smaller .pst
files. (Your network administrator has previously set a size limit to define the
difference between “large” and “small” files.)

If the conversion of a large .pst file is interrupted, the Wizard will temporarily add to
your desktop an icon for the recovery feature, titled “Finish Aborted Sun Java System
Connector Wizard Conversion.” The recovery feature will not work if you simply
restart the Setup Wizard as you ran it for your original conversion; you must start it
from the desktop “Finish” icon, as shown in Figure 8–1.

FIGURE 8–1 To Finish an Aborted Conversion: The Desktop “Finish” Icon

To complete an interrupted conversion: Start the recovery mode of the Sun Java
System Connector Setup Wizard, by double-clicking the “Finish” desktop icon.

The Wizard then displays its Welcome screen, as shown in Figure 8–2, and notifies you
that it has detected an incomplete conversion.
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FIGURE 8–2 Setup Wizard Welcome Screen, to Resume an Interrupted Conversion

This recovery procedure is an abbreviated version of the original Setup procedure, as
described in “The Setup Procedure” on page 19. The Wizard remembers, from its
interrupted run, which user profile and which Personal Folders (.pst) files you
selected for conversion, so it will not prompt you for that information again.

Instead, when you click Next from the Welcome screen shown here, the Wizard skips
ahead to step 5 or 6 of the original Setup procedure: to prompt you for your old
Exchange login information (step 5) if you previously used Outlook on this computer,
or for your new Sun Java System Account login information (step 6) if you will be a
new Outlook user. From step 5 or 6 forward, the procedures are identical, so please
refer to “The Setup Procedure” on page 19.

Logging
This section provides troubleshooting tips for logging and log reports.

Enabling Logging for Troubleshooting
In order to keep track of any problems that may arise with your mail folders or
messages, it is recommended to turn on the logging function for debugging purposes.

� To Enable Logging

1. From the Help menu, select About Sun Java System Connector for Microsoft
Outlook.

Steps

62 Sun Java System Connector for Microsoft Outlook 7 2005Q4 User’s Guide • October 2005



2. In the About dialog, click Debug Logs.

3. In the Debug Logs dialog, enable the checkbox next to Turn on debug logging.

The Log file path indicates the location of the log files.

4. When you are finished, click OK.

Sending a Log Report
You can send a log report of any problems to your technical support representative.

� To Send a Log Report

1. Turn on logging as indicated in “Enabling Logging for Troubleshooting”
on page 62

2. Return to Outlook and attempt to reproduce the steps the caused the problem.

3. From the Help menu, select About Sun Java System Connector for Microsoft
Outlook.

4. In the About dialog, click Debug Logs.

5. In the Debug Logs dialog, enter the email address of your technical support
representative.

6. Click Report.

A new message appears addressed to technical support. A copy of your log file and
your system information is also included in the message.

7. You may enter any more information, or cc anybody else before sending the
message.

Increasing Log Files and Size
Log files are regularly reused and overwritten by new log files. This occurs more
frequently for users with large mailboxes. You can increase the size of your log files or
increase the number of logs files by resetting three registry keys. The registry keys are:

� HKEY_CURRENT_USER\\Software\\Sun Microsystems\\Outlook
Connector

� Maximum Log File Size
� Maximum Number Log Files

Steps
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Assigning Tasks
When assigning tasks to other users, you cannot set different permissions to tasks and
your calendar. The permissions assigned to your calendar applies to your tasks, and
visa versa.

If you are assigned a task, you cannot read the message in your inbox. Move it to one
of your local folders in order to read the task message.

If a Server is Down
If Messaging Server is down, you will be unable to log into Outlook. You can,
however, work in offline mode.

If Messaging Server is working, but Calendar Server or Address Book Server is down,
you can log in to Outlook, but you will be unable make any changes (for example,
create new events, new contacts).

Viewing Message Source
If a message does not display correctly, or if you need a message’s header information
for debugging purposes, you can view the source information of that message.

� To View the Message Source

1. Double-click on a message from the message list.

A new window displays containing the message.

2. In the message window, select View→Message Source.

The Message Source window displays header and source information for the
message.

3. You can copy the information and send it to support for debugging.

4. Click Close to close the window.
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Viewing Message Source While Composing a Message

You can also view the message source while composing a message by selecting
View→Message Source in the Message window.

More
Information
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